AUDIO VISUAL PRODUCTION
(Practical)

Diploma in Multimedia and Animation (DMA)
Audio Visual Production

Block – V: Practical

Odisha State Open University
Audio Visual Production

This course has been developed with the support of the Commonwealth of Learning (COL). COL is an intergovernmental organisation created by Commonwealth Heads of Government to promote the development and sharing of open learning and distance education knowledge, resources and technologies.

Odisha State Open University, Sambalpur (OSOU) is the first Open and Distance learning institution in the State of Odisha, where students can pursue their studies through Open and Distance Learning (ODL) methodologies. Degrees, Diplomas, or Certificates awarded by OSOU are treated as equivalent to the degrees, diplomas, or certificates awarded by other national universities in India by the University Grants Commission.

© 2018 by the Commonwealth of Learning and Odisha State Open University. Except where otherwise noted, Audio Visual Production is made available under Creative Commons Attribution-ShareAlike 4.0 International (CC BY-SA 4.0) License: https://creativecommons.org/licenses/by-sa/4.0/legalcode

For the avoidance of doubt, by applying this license the Commonwealth of Learning does not waive any privileges or immunities from claims that it may be entitled to assert, nor does the Commonwealth of Learning submit itself to the jurisdiction, courts, legal processes or laws of any jurisdiction. The ideas and opinions expressed in this publication are those of the author/s; they are not necessarily those of Commonwealth of Learning and do not commit the organisation.
Acknowledgements

The Odisha State Open University and COL, Canada wishes to thank those Resource Persons below for their contribution to this DMA-05:

Concept / Advisor
Dr. Srikant Mohapatra
Vice- Chancellor
Odisha State Open University, Sambalpur

Course Writer
Bhagbat Kar
Animation Director
News 7, Bhubaneswar

Course Editor
Sanghamitra Padhi
Lecturer in English, JKBK College, Cuttack

Video Production
Durgadatta Kanungo
AIDB trained, Media Person, Doordarshan

Suvendu Mohanty
Anchor, Doordarshan & AIR
Retd. Reader, Swami Vivekananda Memorial (Auto)College, Jagatsinghpur

Published by :
Dr. Jayanta Kar Sharma
Registrar on behalf of Odisha State Open University, Sambalpur

Contribution of following staff members of Odisha State Open University is acknowledged:
- Sambit Mishra
- Debidatta Behera
- Prashansa Das
- Radhakanta Suna
- Abhinandan Tripathy

OSOU and COL acknowledge the support extended by Prof. Madhu Parhar, STRIDE, IGNOU, New Delhi in conducting several workshops in the process of preparation of course material for DMA.
## Contents

### Course Overview 5
- Welcome to Audio-Visual-Production .......................................................... 5
- Recording & Mixing of multi track audio ....................................................... 5
- Script Writing & Budget Making ................................................................. 5
- Shooting for 5 minutes program ............................................................... 6
- Editing of 5 minutes program ..................................................................... 6
- Course outcomes ....................................................................................... 7
- Timeframe .................................................................................................. 7
- Study skills ................................................................................................ 7
- Need help? ................................................................................................. 8
- Assignments .............................................................................................. 8
- Assessments ............................................................................................. 9
- Video Resources ...................................................................................... 9

### Getting around this Course material 10
- Margin icons ............................................................................................ 10

### Unit- 1 11
- Recording & Mixing of multi-track audio .................................................. 11
  - Introduction ............................................................................................. 11
  - Outcomes ............................................................................................... 11
  - Terminology ........................................................................................... 12
  - Why Record? ......................................................................................... 12
  - The Recording Chain ........................................................................... 13
  - Types of Recording ............................................................................... 13
  - Multitrack Recorder and Mixer ............................................................. 15
  - Recording the Mixes ............................................................................ 16
  - Software’s For Audio Recording and Mixing ....................................... 17
  - USB Recording ..................................................................................... 19
  - Reverting an edit or effect .................................................................... 20
  - Mixing Audio Tracks .......................................................................... 21
  - Explicit Mixing and Rendering .......................................................... 25
  - Unit Summary ...................................................................................... 29
  - Assignments ......................................................................................... 29
  - Resources ............................................................................................. 29
# Unit 2

**Script Writing & Budget Making** ................................................................. 30  
Introduction ................................................................................................. 30  
Outcomes ....................................................................................................... 30  
Terminology ................................................................................................... 31  
Script Writing: How to Write a Script? .......................................................... 31  
Starting an AV project in Celtx ...................................................................... 34  
Writing an AV Project in Celtx .................................................................... 41  
Scene Heading ............................................................................................... 43  
Shots ................................................................................................................ 44  
Character ........................................................................................................ 44  
Dialogue ......................................................................................................... 44  
BUDGETING .................................................................................................... 46  
Setting "The Finish Line" ............................................................................... 47  
Budget Sample ................................................................................................ 53  
Unit summary ................................................................................................. 57  
Assessment ...................................................................................................... 57  
Resources ........................................................................................................ 57  

# Unit 3

**Shooting for 5 minutes Program** ................................................................. 58  
Introduction ................................................................................................. 58  
Outcomes ....................................................................................................... 58  
Terminology ................................................................................................... 58  
DSLR: ............................................................................................................ 58  
Production ..................................................................................................... 59  
Equipments for video production .................................................................. 59  
Cameras ......................................................................................................... 59  
Checklist: Before Filming ............................................................................... 60  
How to shoot a Music Video ......................................................................... 61  
How to Shoot Interviews ............................................................................... 66  
Before the Interview ..................................................................................... 66  
The techniques to shoot Interview ................................................................ 67  
How to shoot a documentary ......................................................................... 67  
How to Shoot News ........................................................................................ 72  
Equipment for News coverage ....................................................................... 73  
Precaution ....................................................................................................... 74  
Unit summary ................................................................................................. 75  
Assessment ...................................................................................................... 75  
Resources ........................................................................................................ 75  

# Unit 4

**Editing of 5 minutes Program** ................................................................. 76  
Introduction ................................................................................................. 76  
Outcomes ....................................................................................................... 76  
Terminology ................................................................................................... 77
Editing .......................................................................................................................... 77
How to Edit a Video? ................................................................................................. 78
Choose the Right Software ...................................................................................... 78
Learn the basics of your editing interface .............................................................. 79
Know the essential tools for editing ...................................................................... 80
Organise your Footage .......................................................................................... 81
Create a New Project .............................................................................................. 82
Add transitions and effects to footage .................................................................. 86
Add Music ................................................................................................................. 86
Balancing of Sound ............................................................................................. 87
Adjust the colour ................................................................................................... 87
Titles and Graphics ............................................................................................... 88
Preview video at various point .............................................................................. 88
Unit summary .......................................................................................................... 91
Assessment ............................................................................................................. 91
Resources ............................................................................................................... 91
Course Overview

Welcome to Audio-Visual-Production

On completion of this module the learner will be able to manage a production, from initial stages to the conclusion utilising A/V production methods and paperwork along with understanding a script from concept through storyboarding, shot listing to final editing and utilising the basic principles of shot composition, lighting and shooting. He/she would also be able to demonstrate basics of camera technique and audio recording equipment and will be able to effectively record audio through camera and through standard audio recorders; utilise a digital non-linear editing system to edit video and audio effectively; understand and practically apply key principles of technical theory relevant to digital audio and video - formats, codecs, bit rates, transcoding etc.

Recording & Mixing of multi-track audio

This unit will be like a practical guide for beginners like the recording engineers, producers, musicians etc. — anyone who wants to make better music recordings by understanding recording equipment and techniques. I hope to prepare you all for work in a home studio, a small professional studio, or an on-location recording session.

Script Writing & Budget Making

The purpose of this unit is to help you to make a proper budgeting process with specific examples to help you succeed in producing your own video.
Course Overview

It’s helpful to consider the overall workflow of creating budget and script writing. Decisions such as what the major takeaway message of the video budgeting and scripting will be, what steps to use, and the sequence of budgeting and scripting each have effects on other aspects of the project. This can make it hard to know where to start.

Shooting for 5 minutes program

Shoot can help take your story from merely ‘telling’ to ‘showing’, and can be a very powerful teaching tool if used correctly.

It’s helpful to consider the overall workflow of creating a video. Decisions such as what the major takeaway message of the video will be, what equipment to use and the sequence of filming each have effects on other aspects of the project.

Editing of 5 minutes program

Editing is an essential part of making any film or video. Capturing high-quality video has never been easier, but capturing video is only part of the storytelling process.

You will learn about color correction and grading, video effects and transitions, and more!

This video will provide a brief overview of this course.

<table>
<thead>
<tr>
<th>Topic</th>
<th>YouTube link</th>
<th>QR Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video 2 – Editing, Mixing, Color Correction of the Final Product</td>
<td><a href="https://youtu.be/fSDjkc5E57k">https://youtu.be/fSDjkc5E57k</a></td>
<td></td>
</tr>
</tbody>
</table>
Course outcomes

Upon completion of Audio-Production you will be able to:

- Explain the Process of Sound Recording.
- Describe Voice Dubbing process.
- Use the software Celtx for scripting
- Plan to shoot News, Music Video, and Documentary.
- Practice the steps of Editing

Timeframe

This course will be completed within “2” classes.

This course is of “1” credits.

2 Hours of study time is required to complete this unit.

Study skills

Learning about the audio visual productions are a part of Multimedia Coaching. But, when it comes to creation of an output, there is no specific ABC formula for doing so. It is just like a painting in which the artists choose the colour and proportion according to the need, not as per a written plan.

In creating outputs for TV, Films etc. we have to utilize the software tools from one corner to another randomly. So for every project, the formula is different. There is no fixed recipe for all kind of output. So, the more and more you learn about the options, more variety you will get. Each and every option is explained step by step in the course material.

Apart from this course material, the learner has to adopt the tendency of learning from multiple sources i.e.,

- Internet tutorials
Course Overview

- Video tutorials on youtube
- Collaboration with people working in the industry etc.

Only classroom study will not make you a professional. You have to be active to grab the opportunity of learning wherever you get a chance.

---

Need help?

In case of any help needed you can browse the internet sites like youtube.com for video tutorials about the subject.

---

Assignments

There will be some assignments at the end of each unit.

These assignments are mostly practical based and should be submitted in CD or DVD. Theoretical assignments are to be submitted neatly written on A4 size sheet.

All assignments will be submitted to respective study centre of Odisha State Open University or as directed by Co-ordinator.

All assignment should be unit wise on separate CD/DVDs clearly mentioning course title and unit on Top. Theoretical Assignment will be neatly filed or spiral bind with cover clearly mentioning necessary information of course.
Assessments

There will be “1” assessment for each unit.
All practical assessment will be submitted to OSOU.
Assessment will take place once at the end of each unit.
Learner will be allowed to complete the assessment within stipulated time frame given by the university.

Video Resources

This study material comes with additional online resources in the form of videos. As videos puts in human element to e-learning at the same time demonstrating the concepts visually also improves the overall learning experience.
You can download any QR code reader from Google Play to view the videos embedded in the course or type the URL on a web browser.
Getting around this Course material

Margin icons

While working through this Course material you will notice the frequent use of margin icons. These icons serve to “signpost” a particular piece of text, a new task or change in activity; they have been included to help you to find your way around this Course material.

A complete icon set is shown below. We suggest that you familiarize yourself with the icons and their meaning before starting your study.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Assessment</th>
<th>Assignment</th>
<th>Case study</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discussion</td>
<td>Group activity</td>
<td>Help</td>
<td>Note it!</td>
</tr>
<tr>
<td>Outcomes</td>
<td>Reading</td>
<td>Reflection</td>
<td>Study skills</td>
</tr>
<tr>
<td>Summary</td>
<td>Terminology</td>
<td>Time</td>
<td>Tip</td>
</tr>
</tbody>
</table>
Unit- 1

Recording & Mixing of multi-track audio

Introduction

This unit will be like a practical guide for beginners like the recording engineers, producers, musicians etc. — anyone who wants to make better music recordings by understanding recording equipment and techniques. I hope to prepare you all for work in a home studio, a small professional studio, or an on-location recording session. Practical Recording Techniques offers up-to-date information on the latest music recording technology, such as hard-disk and Flash memory recorders, computer recording, loop-based recording, keyboard and digital workstations, MIDI, surround sound, Web audio, and online collaboration. But it also guides the beginner through the basics, showing how to make quality recordings with the new breed of inexpensive home-studio equipment.

Outcomes

Upon completion of this unit you will be able to:

- State the reasons for recording
- List the types of recording
- Name the software’s for recording
- Plan to record an Audio
Terminology

**Ambience:** Room acoustics, early reflections and reverberation. Also, the audible sense of a room or environment surrounding a recorded instrument.

**Control room:** The room in which the engineer controls and monitors the recording. It houses most of the recording hardware.

**Delay:** The time interval between a signal and its repetition.

**Effects:** Interesting sound phenomena created by signal processors, such as reverberation, echo, flanging, doubling, compression, or chorus.

**Signal:** A varying electrical voltage that represents information, such as a sound.

Why Record?

Recording is a genuine service. Without it, individuals would be presented to substantially less music. They would be restricted to the intermittent live concert or to their own particular live music, played once and everlastingly gone.

With recordings, you can protect an execution for a huge number of listeners. You can hear a tremendous assortment of musical articulations at whatever point you need. Not at all like a live concert, a record can be played again and again for examination. Tapes or circles are likewise an approach to accomplish a kind of eternality. The Beatles might be gone, yet their music lives on.

Records can even uncover your advancing awareness as you develop and change. A PC audio file or CD remains the same physically, however you hear it contrastingly finished the years as your recognition changes. Recordings are a steady against which you can quantify change in yourself.
The Recording Chain

This SLM will demonstrate to you a review of current recording technology, enable you to pick the gear that best suits your necessities, and guide you in utilizing it to make incredible recordings. What's more, it will clarify the specialized language in plain English.

As a recording engineer, you're a key player. Your abilities enable craftsmen to understand their dreams in sound. Your miking techniques capture the energy of the execution, regardless of whether it's the gleaming suggestions of a string group of four or the sonic attack of an electric blues band. Your "post" work in the studio—adding effects, tweaking levels, and so forth.— will take the crude material of the execution and shape and mix it into a cleaned musical articulation. By mastering the technology and getting to be noticeably familiar with the audio tools nearby, you will produce exciting recordings that will amuse your customers and give you a genuine feeling of pride and accomplishment.

Types of Recording

Let’s get started with some best ways to record music.

Live Stereo Recording

Here we will talk about recording with a stereo microphone or two microphones into a recorder. This technique is most normal when used to record an orchestra, symphonic band, pipe organ, small ensemble, quartet, or soloist. The microphones get the general sound of the instruments and the concert-hall acoustics from a few feet away. You may utilize this moderate system to record a society group, shake group, or acoustic jazz group in a good-sounding room.

1. The musical instruments or voices make sound waves.
2. The sound waves go through the air and bob or reflect off the dividers, roof, and floor of the concert hall. These reflections include a satisfying feeling of openness.
3. The sound waves from the instruments and the room achieve the microphones, which convert the sound into electrical signals.
4. The sound quality is significantly influenced by mic method: microphone decision and situation.

5. The signals from the microphones go to a 2-track recorder. It might be a hard-drive recorder, CD-R burner, DVD-R burner, Flash memory recorder, or computer hard drive. The signal changes to a pattern stored on a medium, for example, attractive patterns on a hard disk. During playback, the patterns on the medium are converted once again into a signal. During recording, signals are stored along a track—a way or channel on the medium containing a recorded signal. A single medium can record one or more tracks. For instance, 2-track hard-disk recording stores two tracks on the hard disk, for example, the two different audio signals required for stereo recording.

Live Mix Recording

This strategy is from time to time utilized with the exception of live broadcasts or recordings of PA mixes. Utilizing a mixer, you set up a blend of several microphones and record the mixer's yield
signal on a 2-track recorder (CD-R, Flash memory recorder, or computer hard drive). Each mic is near its sound source.

**Multitrack Recorder and Mixer**

Try to record with several mics into a mixer, which is associated with a multitrack hard-disk recorder. You record the signal of every microphone all alone track; at that point blend these recorded signals after the performance is finished. You can likewise record different groups of instruments on each track.

1. Place the microphones near the music instruments.

2. Plug the mics into a mixing console: a professional audio mixer. During multitrack recording, the mixing console increases the frail microphone signals up to the level required by the recorder. The console additionally sends every microphone signal to the desired track.

3. Record the amplified mic signals on the multitrack recorder.

**Stand-alone DAW (Recorder–Mixer)**

This is a multitrack recorder and a mixer combined in one portable frame. It’s relatively simple to utilize. The recording medium is a hard drive or a Flash memory card. Other names for a recorder–mixer are "stand-alone Digital Audio Workstation," "digital multitracker, “personal digital studio, " or "portable studio.” Most recorder–mixers have built-in effects.
Recording the Mixes

Regardless of which recording strategy you utilize, in the long run you’ll mix every melody and record the mix on a 2-track recorder, or record the mix as a stereo WAVE document on your hard drive. You can change over the WAVE document to a MP3 or WMA organize for uploading to the Web. You should need to amass a collection of your recorded mixes. To do this expel noises and tally offs between tunes, put the melodies in the coveted request, and put a couple of moments of quiet between tunes. This is finished with a PC and altering software. The last advance is to duplicate the collection to a clear CD. There’s your final product, prepared to copy or duplicate.

Regardless of what sort of recording you do, each stage adds to the sound quality of the got done with recording. An awful sounding CD can be caused by any frail connection: low-quality microphones, insufficient mic placement or mixer settings, et cetera. You can make progress toward quality recordings by advancing each stage.

It gives you a chance to do complex altering and computerized mixing. A few plug-in (software) impacts are incorporated, and you can buy and install other plug-ins. Recording software can be refreshed at little cost. With respect to disadvantages, PCs can crash and can be hard to set up and optimize for audio work.
Software’s For Audio Recording and Mixing

A few software for audio recording are listed below for you:

- Audacity
- Ardour
- Traverso
- Qtractor
- Nuendo
- Pro tools

How we record audio?

So let us start with a couple of advances to record audio...

Audacity is an extremely solid audio program; it's an open source program for sound recording and mixing. It's accessible for every operating framework, effective audio recorder and manager that can do substantially more than you would envision from an open source program. Its interface is somewhat covered in places, so you may get yourself a little overpowered when you first utilize it.

Start Audacity: a new untitled project window opens. Click on File >Save project As... And save the project with a name.

Set the recording source to microphone in Audacity's mixer toolbar recording selector Mixer Toolbar (or on OS X, set the microphone as the default recording source in Apple Audio MIDI Setup).

You are now ready to record the Sound. Don't worry about mistakes, pauses, and cough and similar - we can edit those out later. In fact you may want to make a few deliberate mistakes so you can practice editing them out later. When you stop to make a correction, go back to the start of a natural break - sentence or phrase - and start again in a normal voice: once you've tried to edit out your mistakes you will realize the importance of this.

To record:

- Set the Recording Device,
- monitor and then adjust the recording level,
- then press the red Record button.

Correct adjustment of level before recording is essential to avoid noise or distortion.
1. Set the Recording Device either in the Devices section of Preferences or in Device Toolbar.

2. Click in the Recording Meter to start monitoring as in the following image:

   ![Screenshot](image1)

   **Screenshot**

3. Singing or playing the loudest part of what you are recording, adjust the recording level using the right-hand slider on Mixer Toolbar:

   ![Screenshot](image2)

   **Screenshot**

   So that the moving meter toolbars do not get too close to the right-hand edge of the meter.

4. Optionally, turn on Transport > Software Playthrough (on/off) (so it has a check mark) to hear what the recording will sound like. Don’t enable Software Playthrough when recording playback, because it creates echoes. To hear what a recording of computer playback will sound like, make a test recording to check the level before recording for real.

   ![Warning](image3)

   **Warning**

5. Press the red Record button to record for real.

6. Audacity will record until you stop the recording using the yellow Stop button.

**To record a specific length of time**

1. Use Tracks > Add New to create a new track if there are no tracks yet
2. Drag-select a region in an existing track or choose the selection to be recorded in Selection Toolbar

3. Ensure Transport > Overdub (on/off) is enabled (on) which is its default setting, then press Record to record in a new track. Alternatively, try Timer Record.

**USB Recording**

- Connect the USB cable of the turntable, or tapedeck, to the computer, and then launch Audacity. If Audacity was already running when you connected the cable, restart Audacity or choose **Transport > Rescan Audio Devices**.
- Use the device toolbar to set the recording and playback devices and set the channels to "2(stereo) Recording Channels":

  ![Screenshot]

- From the transport menu check "**Software Play through**" to be "on" to hear the turntable through the computer speakers; this setting can be toggled on/off easily from the Transport Menu.
- Then, **ignoring any instructions in the manufacturer's guide to select "stereo mix"**, simply press the red Record button in transport toolbar to start recording from the turntable.

**Edit**

The main commands for editing audio are under the **EDIT MENU** and the **EFFECT MENU**.

⚠️ When playing, recording or paused, most of the Edit Menu and all of the Effect Menu will appear greyed out. Changes to the audio data cannot be made until you press the yellow **Stop** button.
The most common editing actions such as CUT, COPY, PASTE and DELETE also have buttons in EDIT TOOLBAR. Effects let you do things like boost the bass, change pitch or tempo, or remove noise in various ways. Find the correct effect to do what you want on the INDEX OF EFFECTS, GENERATORS and ANALYZERS page.

Edits

Audacity applies each edit to a selected area of the audio track or tracks. To select a particular area, click in the track and drag the shaded area with the mouse. If no audio is selected, Audacity by default selects all the audio in the project window.

The Tutorial Editing an Existing Audio File has more detailed information on how to edit audio.

Effects

To apply an effect you need to first select some audio, then click on the effect you require from the Effect Menu, then make any parameter settings in the dialog box that you want and then press the OK button to apply the effect. Note that a few effects have no parameters that can be set and these are applied as soon as you click on them in the Effect Menu; An example is: Cross Fade Tracks.

For the effects that have settable parameters the dialog box contains a Preview button which enables you to hear a short sample of the audio with the effect temporarily applied so that you can audition the result prior to accepting the settings you have made.

Reverting an edit or effect

If you are unhappy with the result of your edit or effect you can simple use the Audacity UNDO command or use the CTRL-Z keyboard shortcut. A good tip for effects is to try them out on a short section of audio first to try it out on a longer section than preview allows and then use the UNDO.
Marking edit points

You can mark edit points or regions in your audio labels. These can be useful for recalling the edits when saving and reopening a project. They can also be useful to mark splits in a long audio track that is to be exported as multiple files.

Save

There are two main commands for saving projects:

- **File >Save project** saves an .aup project file and a _data folder containing the actual audio.
- **File >Save project as** is for saving an empty project. It also lets you save an existing Project with a new name.

When saving an Audacity project it is normally easiest to use the **File >Save project** command, which has a default shortcut of **CTRL + S**. If you save a project again having made further changes to it, "Save Project" then updates the .aup file and _data folder silently without bothering you with prompts.

If the project does not have any unsaved changes (for example, if the project is empty or you just saved it), "Save Project" will be grayed out. In that case, use **File > Save project as** instead. "Save Project As" is the safe and recommended way to make a copy of a project with a new name or in a different location. This could serve either as a single backup copy of the project, or as one of several incremental copies of the project in the state it had at a particular date and time.

Open

To re-open a saved project:

- choose **File >Open**
- Or use **File >Recent Files** and open the .aup file.

Mixing Audio Tracks

Mixing refers to the process of combining multiple Audacity tracks which play simultaneously into a single track.
Audacity mixes automatically when playing or exporting, but it can also physically mix selected multiple tracks together into one within the project.

The channel of a track being mixed affects whether it will be mixed into the left channel of the resulting track(s), the right channel, or both (mono). For example, if you have four tracks:

Mixing can be done for a number of reasons, for example mixing speech with background music to make a podcast, or adding different instruments into the same song. Concatenating songs (for example, playing three songs one after the other) does not necessarily involve mixing, but if you wanted the songs to fade into each other it would involve mixing.

Within an Audacity project, you can physically mix selected multiple selected tracks into a single mono or stereo track using either of two explicit mix commands:

- Track 1: left channel
- Track 2: left channel
- Track 3: right channel
- Track 4: mono channel

You select them all and perform a Mix and Render, you will end up with one stereo track: the left channel will contain a mix of tracks 1, 2, and 4 and the right channel will contain a mix of tracks 3 and 4.

Within an Audacity project, you can physically mix selected multiple selected tracks into a single mono or stereo track using either of two explicit mix commands:

- **Tracks > Mix and render** (which replaces the original track(s) with the mixed track) or
- **Tracks > Mix and render to new track** (which adds the mixed track to the project, preserving the original tracks).

However in Audacity, mixing is automatic. You could just put audio into two different tracks, Play to listen to the result then Export it as an audio file like Mp3 or Wav or burn the WAV to Audio CD.
However once audio has been finally mixed (as in an audio file you might import into Audacity) it is essentially impossible to separate out all the original parts again; it's like trying to take the banana out of a banana milkshake after you've already put it through the blender. There are a few occasions when it actually is possible to separate sounds a bit - you can sometimes isolate the bass, or remove the lead vocals. But these processes don't always work well and usually cause some quality loss. So remember, as long as the multiple tracks are inside an Audacity project, you can manipulate them independently, but once you export as a mixed down file you can't expect to separate the different parts again. So keep your Audacity project around if you plan to continue editing!

Although Audacity by default exports files as either two channel stereo or single channel mono (if exporting unpanned mono tracks), you can also export multi-channel files having more than two channels, such as a 5:1 file. To enable this, choose "Use custom mix" in the Import / Export Preferences.

The controls used for mixing are the Mute and Solo buttons and the Gain (-.....+) and Pan (L.....R) sliders.

Title- Mixing of Audio at Audacity Timeline

In the above example, mixing the mono (upper) and stereo (lower) track means that the audio of the mono track will be heard equally in both left and right channels of the resulting stereo mix.

**Muting and Soloing**

When working with multiple tracks, it's often important to be able to hear just one at a time. Each track has a Mute and a Solo button, allowing you to temporarily hear just some of your tracks - see the figure above.

- **Mute** causes a track to be silenced. More than one track can be muted.
- **Solo** can behave in two different ways depending on the setting made in Tracks Preferences.
  - Default behaviour is that Solo silences all of the tracks except the ones being soloed. More than one track can be soloed and soloing overrides muting.
  - Alternative behaviour is that only one track can be soloed at a time. Soloing still overrides muting.

A third option in Tracks Preferences is to hide the Solo button from tracks, leaving just a Mute button which silences whichever tracks it is applied to.

You can press the Mute and Solo buttons while tracks are playing.

If you're using the keyboard, \texttt{SHIFT+U} toggles muting on the currently focused track which has the yellow border, and \texttt{SHIFT+8} toggles soloing. The solo shortcut works even if you hide the Solo button.

Sometimes it can be handy to export a preliminary mix with one or more of the tracks left out. Exporting will automatically ignore any tracks on which the Mute button is pressed.

**Gain and panning**

Above the Mute / Solo buttons, each track has a \texttt{-/+ gain} slider which adjusts the track's volume, and an \texttt{L/R pan} slider which adjusts the track's stereo position in the overall mix - whether it comes from the left speaker, right speaker or in-between.
change the value, just click on the slider and drag. For finer control when dragging, hold \texttt{SHIFT} while dragging or double-click on the slider or slider scale to enter a precise value as text.

The normal range of gain is from \textbf{-36 dB} to 36 dB. If you need more, choose \textit{Effect > Amplify}.

If you’re using the keyboard, use:

- \texttt{ALT + SHIFT + UP} to increase the gain on the focused track or \texttt{ALT + SHIFT + DOWN} to reduce it
- Use \texttt{ALT + SHIFT + LEFT} to pan left on the focused track or \texttt{ALT + SHIFT + RIGHT} to pan right.

Or press \texttt{SHIFT + G} to adjust the gain in a dialog box or \texttt{SHIFT + P} to adjust the pan.

If you don’t see the gain or pan slider for a track, you may need to make it taller. Position the mouse on the bottom edge of the waveform and drag downwards. You can use the button with the upward pointing arrow (below the pan slider) to collapse the track upwards to a minimal height.

**Explicit Mixing and Rendering**

While mixing is automatic, there are times when you may want to explicitly tell Audacity to mix several tracks. This is useful in several ways:

- You can consolidate tracks which you have finished working on, making it easier to see the other tracks without scrolling up and down.
- Playback may respond more quickly with fewer tracks.
- You can see what the final mix will look like as a waveform so as to check the overall level of the final mix before exporting it.

To mix explicitly, select all the tracks you want to mix together then choose either Tracks > Mix and Render or Tracks > Mix and Render to New Track (shortcut \texttt{CTRL + SHIFT + M}).

For mouse users, a quick way to select multiple tracks is to select the first track by clicking on its Track Control Panel, then hold
SHIFT while clicking on the Track Control Panels of the other tracks you want to select.

Several things happen when you choose either Mix or Render command.

- All selected tracks are mixed down to a single track called "Mix".

- If you choose "Mix and Render", the resulting "Mix" track replaces the selected original tracks.

- If you choose "Mix and Render to New Track", the original tracks are preserved so that the resulting "Mix" track becomes an additional track in the project.

- The "Mix" track is always placed underneath any non-selected or remaining tracks.

- The new mixed track will be stereo unless the tracks you mixed were mono tracks panned to center.

- If any of the original tracks did not match the sample rate of the project (set at bottom left of the project window in Selection Toolbar), they will be resampled to match the project rate.

- Any envelope points defining amplitude modifications will be applied and the previous envelope points removed.

- Gain and panning changes will be applied and the sliders reset to normal in the mixed track.

- Mute and Solo button states will be released.

You can always Edit > Undo if you’re not happy with the results of Mix and Render, then make changes and try it again.

**Mixing Levels**

The act of mixing multiple tracks *adds* the waveforms together. In most cases this will cause the mixed track to have a higher peak and RMS (average) level than the individual pre-mixed tracks, though this is not *always* true by definition. How much (or whether) the peak level increases and how much louder it actually
sounds depends on how related the waveforms of the mixed tracks are.

When peaks or troughs in the waveform coincide, the waveforms will reinforce each other, leading to an increased signal level. In fact if you combined two identical tracks, the signal level would exactly double, leading to an increase in peak level of 6 dB. But when a peak in one track coincides with a trough in another track the waveforms will tend to cancel each other out, leading to a lower level in the mix at that point.

Also the more tracks that have audio at the same point on the Timeline, the higher the mix level is likely to be.

The overall mix level is indicated on the Playback meter when the project is playing. You can see individual meters for each track (showing the levels as modified by the track's gain/pan sliders and mute/solo buttons) if you enable View >Mixer board.

Because mixing tracks is additive, the combined level may show clipping distortion in the Meter Toolbar. In that case, you should use the gain sliders on one or more tracks to reduce the overall level.

- If you already have the balance of the mix (the levels of the tracks relative to each other) exactly as you want it, select all the tracks using CTRL + A then choose Effect > Amplify. Enter a negative value in the "Amplification (dB)" box which will reduce the level of all the tracks by the specified value.

**Save and Export**

The "File > Save" command just saves the Audacity project. You need to export your project in order to use it with other audio programs. When you export your project, Audacity automatically mixes it, so the exported file sounds just like what you hear when you click the Play button.

Make sure there are no unwanted bits of audio far along the time line or your exported file will be unexpectedly long! Click on the Fit Project button in the Edit Toolbar. If the expected length of your final mix is displayed in the window, all is fine. If the
displayed time line is much longer than your actual production, look for the unwanted bits of audio and delete them. You may need to click just past the real end of your narration/music and delete everything from there to the end of the track(s).

**Backup**

Backup your exported WAV or MP3 files - you don't want to lose all that valuable work and have to do it all over again, do you? Computer hard drives can fail, destroying all data.

Ideally use a dedicated drive (*1+ TB external drives are convenient and economical*), or upload to an online (cloud) storage service, to store the WAVs or MP3s. Better still is to make two copies on different external devices and even better is to hold an off-site backup.
Unit Summary

In this unit you learned the basic of recording & mixing of multi track audio. Now you will be able to explain about the ‘elements of recording & mixing’ and ‘Principles of recording & mixing’. How to add aesthetics to any composition? Why these elements are important for any project.

We also addressed about ‘Fundamental of recording & mixing’ and able to distinguish mono and stereo. How their properties are different from each other? You also learnt the different Studio setup Techniques, the recording chain systems, types of recording and mixing the multiple channels.

Assignments

1. List the equipment used in audio recording process?
2. List the steps to record in stereo?
3. Explain the need of using principle of recording?
4. Describe the use of mixing.
5. State the role of Mixer?
6. Practice importing different audio files into your project from internet.
7. Practice importing audio from CD/DVD or from Web.
8. Try to save Audio projects from webpage to your computer drive.
9. Differentiate between mono and stereo recording.
10. List the primary tools for recording?

Resources

- https://google.com
- http://wikipedia.com
- https://www.prepressure.com
- http://www.youtube.com
- http://www.audacityteam.org
Unit 2

Script Writing & Budget Making

Introduction

Almost every facet of the filmmaking process is distinguished by its lack of predictability. Anyone who has attempted to make a film will attest to this simple truth. Not only is filmmaking a complex medium from a technical standpoint, it's a medium that places the filmmaker at the mercy of his own abilities and limitations, as well as those of his associates. Throw in weather and logistical problems, which multiply in proportion to the complexity of the production, and you, can see why making a feature film is very difficult indeed. With that said, the best protection for the filmmaker is adequate advance preparation. This includes a realistic and carefully constructed production budget.

The purpose of this unit is to help you to make a proper budgeting process with specific examples to help you succeed in producing your own video.

Outcomes

Upon completion of this unit you will be able to:

- Write an Audio script
- Name the various Scripting Software
- Use the software Celtx
- Prepare a video Budget
- Make a Sample Budget
**Terminology**

**Script:** A written format used for TV & Cinema production.

**Budget:** Detail planned & non planned expenditure of any TV & Film Production.

**Top sheet:** One page summary of the budget.

**Dialogue:** Conversation between two characters.

**Transition:** The way one shot changes to the next.

**Celtx:** Software used for script making.

**Script Writing: How to Write a Script?**

Once you've picked a topic, it's a great opportunity to compose that script. The script doesn't need to be extravagant. You're not endeavoring to submit this script for any honors or hang it in the lobby. It's motivation is entirely utilitarian. A decent script makes it simple for the people on camera to communicate as the need should arise while sounding and acting characteristic.

**Write in Plain, Conversational English.**

Writing a script isn't the same as writing a school paper or promoting research report. You need to compose the script how you need the video subject to talks. On camera, saying, "I will make a video in the wake of perusing this unit" will read much better than "I am will make a video subsequent to perusing this unit."

**Make it Thorough.**

A script doesn't simply incorporate dialogue. On the off chance that your video will require multiple shots, characters, or scenes, incorporate these subtle elements. Be certain to incorporate any essential data about the set or stage activities, for example, a wardrobe change. Basically, you need the script to be sufficiently
exhaustive that you could hand it off to another person to shoot. Separate the fundamental story from B-Roll, text overlays, and voiceover utilizing distinctive formatting or callouts.

If the transition will show from a subject talking the essential account to a close-up shot of your item with a text overlay, you'll need to call that out in your script so any individual who understands it comprehends what's supposed to be perused on screen versus consolidated in the editing procedure.

**Script Every Word.**

It's understandable to figure you can simply scribble down the primary bullet points for a script and after that simply wing it on camera, particularly on the off chance that you know your subject issue. This approach makes it intense to impart a message as obviously and briefly as could reasonably be expected (which you should plan to do in each video you make), and it as a rule brings about a considerable measure of re-dos.

In this way, doing this will keep you sorted out amid recording and spare you heaps of time later.

**Influence It To brief.**

Shorter videos are better than long videos, and to make short videos, you require a short script. Try not to compose a script any longer. On the off chance that you can keep it to the base page, stunningly better. It's additionally worth completing a few rounds of alters exclusively centered around cutting all pointless fat.

**Set the scene.**

Keep in mind to incorporate essential points of interest, for example, time of day, setting, and actions of the characters in the scene. These are about as imperative as the dialogue that happens.

**Tissue out your story**

Compose the whole commence of the play, motion picture, and so on with heaps of subtle elements and thoughts, paying no psyche
to style, configuration, reiteration, or whatever else that impedes your innovative stream. Your completed item should cover the plot, personalities, connections, character circular segments, and a bigger point to the story. Some of the time, drawings or diagrams might be utilized as a brief storyboard to show to different people to exhibit aspects of your plot and characters, and so forth. Your characters should drive the activity on the stage or screen, so ensure they are intriguing and inventive. It may not be fundamental for you to completely create them immediately, be that as it may, as they tend to go up against lives of their own as the script-writing proceeds.

**Invest a lots of time in Dialogue**

The dialogue will represent the moment of truth your characters and their connections. What's more regrettable, the dialogue is amazingly troublesome for a great many people to compose. To get your bearings, record or record genuine discussions to perceive how people truly talk and which articulations they utilize. Be certain to tune in to an assortment of speakers so you can give your own particular characters more flavor and independence. Guaranteeing that distinctive characters have their own "voice" and "persona" based on their background will shield them from blending into each other. Remember, their persona will influence their mentality, word decisions and lingo. Read your dialogue so anyone might hear as you go, giving careful consideration to regardless of whether it sounds stopping, stereotyped, over-the-top, or absolutely uniform.

**Keep up your style**

Scripts are about activity and discourse. Ensure your characters talk reasonably and do whatever it takes not to blend styles of discourse and vocabulary a lot of unless you are going for a specific impact.

**Research after the first draft**

Watch plays, TV shows, and motion pictures which are like the work you've quite recently composed. Analyze your own work in contrast with these others. Do you fall into numerous tropes?
your story over done? Check whether you can discover approaches to separate yourself from these works.

Work on making significant contributions to the subject you has composed. Adopt a philosophical strategy to the topic and test regular thoughts. This will make your work significantly more captivating.

**Scripting Software's**

You might possibly require scriptwriting software to enable you to compose your script. A basic 2-column Audio/Video script format is regularly bounty for the normal script. A 2-column layout can be made for nothing from your pledge processor.

Be that as it may, on the off chance that you are shooting a considerable measure of re-establishments for your film (half movie, half documentary sort of thing), some scriptwriting software could prove to be useful to enable you to block out the scenes. Celtx is great decisions for this.

- Celtx
- Trelby
- Fountain
- After writing

**Starting an AV project in Celtx**

So, my example project for this chapter is how I set up "Celtx Half Married" in Celtx.

**Beginning new AV Project**

We start our project by making a directory on our computer. Having a separate directory for our projects makes it a lot easier to organize and to find stuff when we need it. Therefore, I first create the new empty directory on my hard drive named Celtx Half Married, as shown in the following screenshot:

![Screen shot](image-url)
Now, open up Celtx. In a moment, left click on Audio-Visual to open a project container that has an Audio-Visual script in it. However, first, since I have not mentioned it to date, look at the items outside the Project Templates and Recent Project boxes in the lower part of the splash page, as shown in the following screenshot:

As Celtx is connected to the Internet, we get some information each time Celtx starts up from the servers at: http://celtx.com. This information from online includes links to news, help features, ads for Celtx add-ons, and announcements. Next we open an audio-visual project in celtx.
This gives us a chance to check out those five script elements we met earlier by left clicking on the downward arrow next to **Scene Heading**. In the next section, we'll examine each and use them.

### Setting up the Content

Continuing with the initial setup of the container for this project, rename the A/V Script in the **Project Library**. Just for example, the project name was renamed, as Half Married. Also, remember we can have hundreds of files, directories, subdirectories, and so on in the **Project Library**. Just right click on **A/V Script**, choose **Rename...** and type in the new title, as shown in the following screenshot:

![Screenshot of Project Library]

Left click on **File** at the top left of the Celtx screen, then on **Save Project As...** (or use the Ctrl+ Shift +S key shortcut) to save the project into your new directory, all properly titled and ready for action, as shown in the following screenshot:

![Screenshot of Celtx Loves Indies]
Title Page

If you want to add a title page to all scripts, then follow the steps. To have a title page included in the print out of an Audio-Visual project, left click on the TypeSet/PDF button at the bottom of the main script window, as shown in the following screenshot:

![Screenshot]

At the point when the Typeset/PDF screen opens in the main window of Celtx, left click on the Format Options catch at the best. The Format Options dialog box opens, as appeared in the accompanying screenshot:

![Screenshot]

Under the General tab of the Format Options dialog box (in the previous screenshot), we have to ensure a few options are verified. Paper Size is the print yield page size of the PDF files (not really that of your printer). For instance, you may live in India and print on A4 paper utilizing the Print button at the highest point of the Celtx screen. In any case, the content is being submitted to a maker in America, who might print on the U.S. Letter. Utilizing the Paper Size choice, we can produce PDFs having distinctive paper sizes that may be our local standard. Next, down in the box, click in the hover to the left of Two Columns. Industry standard audio-visual scripts utilize a two-column format. The left column
contains camera shots and alternate bearings. The right column has characters and dialog (who talks and what they say). This is appeared in the accompanying screenshot:

As we're right at it, let us say the Shot List decision. Once our audio-visual script is done, we can check here to generate and print a list of shots. This would be valuable for the camera operator in setting up scenes, and resembles the accompanying:

For the time being, we need the two-columns format chose. To complete out this tab, check Show Scene Headers (we need to see the titles of the scenes in our sample script) and Title Page on the grounds that as expressed before, we need to incorporate a title page.
We won't utilize the Script Header tab in this task, however in the event that you ever need to, it replaces the title page with a data page listing the fields that can be rounded out in this tab, as appeared in the accompanying screenshot:

![Screenshot](image)

You would discover a script header more useful for internal use in an extensive organization where a few people chip away at the project and the data is more critical than appearances. This dialog box does not enable you to choose both in the event that you needed a cover sheet and the script heading data. In any case, that is anything but difficult to get around; simply duplicate the completed script by right-clicking on its name in the Projects Library and selecting Duplicate. You'll have two scripts of a similar name. In one, you can have a cover sheet and in the other the PDF prints out with the script header data. You should need to change the name marginally, so it's undeniable which has what.

**Adding a Title Page**

Affirm, now that we've disclosed to Celtx we need a title page incorporated, we should set one up. Left click on the Title Page button at the button of the main script window, as appeared in the accompanying screenshot:

![Screenshot](image)
The title page form, as we've seen most as of late in title page, shows up in the main script window of the Celtx screen, as appeared in the accompanying screenshot:

Round it out by typing in the boxes. The undertaking title, creator's name and contact data have been entered. Additionally, copyright included. Utilize air conditioning in brackets (c) to show the copyright symbol. While you could type the Alt-0169 key blend for a real "c around" copyright symbol, the PDF conversion software on Internet does not change over it effectively, so utilize the above workaround. It's similarly as lawful. Everything else, including varying media contents, ought to have a copyright take note.

Presently, the way copyrights work is basic, particularly under Indian copyright act, 1957. When you complete a work, it is naturally copyrighted. Rounding out structures to do that on the web and sending in cash just registers the copyright, on the off chance that you do need it, do what needs to be done on the web.
Tap on the Typeset/PDF button once more (base of the primary content window), as appeared in the accompanying screenshot:

![Screenshot]

Celtx sends our title page out on the Internet, groups it, and returns it to our PC, showing it in the main script window, as appeared in the accompanying screenshot:

![Screen shot]

We could spare the cover sheet as a PDF document to our hard disk by tapping on the Save PDF button at the highest point of the main script window, yet it's not justified, despite any potential benefits until the point when we have a portion of the script composed. The data we rounded out and changes in setup on made as of now are spared each time the Celtx venture gets spared, so nothing is lost.

**Writing an AV Project in Celtx**

A varying media script is composed utilizing the five script components in the Audio-Visual venture script, which are Scene Heading, Shot, Character, Dialog, and Parenthetical. A script in advance—Celtx Half Married—is appeared in the accompanying screenshot:
A couple of pages back, we talked about how wide an assortment of varying media preparations Celtx’s varying media venture script alter spreads and all finished with those five script components found in the drop-down menu at the highest point of Celtx’s main script window. You can see it in the previous screenshot; it is demonstrating Dialog right now.

When completed and conveyed on the Internet for a relatively moment conversion to PDF, a completed page resembles the accompanying:
Scene Heading

Scene headings work definitely as they improved the situation us while composing the spec script in above, just they look somewhat changed. The word INTRODUCTION: in the accompanying screenshot is the name of this scene:

![Screenshot](image)

We write the scene heading in any blend of upper and lower case and, in as much as we have Scene Heading chose in the script components drop-down menu, Celtx places it in ALL CAPS and includes a colon when it designs into a PDF. The former screenshot demonstrates what it would seem that in our script. Here it is when arranged into a PDF:

![Screenshot](image)

Scene headings automatically show up in the Scenes box to one side of the Celtx window under the Project Library. As in a Celtx script, we can utilize these scene headings in the container to move scenes around in the script, delete scenes, or as a navigation help in moving to a chose scene in the script. Additionally, tapping on the small box with an or more sign (+) in it (if more than one shot is in the scene) gives us a rundown of shots, as appeared in the accompanying screenshot:
**Shots**

The Shots script element alludes to camera shots. These can be industry standard shot names, or more casual directions for the camera operator or video editor, or a mix like the accompanying:

<table>
<thead>
<tr>
<th>MEDIUM: Shot of me with green screen behind. Use video wall effect with cut takes from several video.</th>
</tr>
</thead>
<tbody>
<tr>
<td>BHAGABAT: Hi, I'm Bhagbat Kar - Writer of this Celtx beginners unit and an animation director. As a director, I know our two most favorite words in all the universe are low budget.</td>
</tr>
</tbody>
</table>

Choosing the Shot script element and typing the shot makes Celtx organize it in the left segment when the PDF is made.

**Character**

The Character script element signifies somebody who talks. In the previous illustration, that would be me. When we write a character name with the Character element chose, Celtx capitalizes and underlines it, and spots it in the correct segment. Gracious yes, Celtx makes our typing speedier by provoking us. Sort a scene heading, hit the Enter key, and we are automatically in shot mode. Sort the shot and hit Enter, we are in character, at that point in dialogue, and back in character, etcetera. We secured key alternate routes before; they can really accelerate your productivity.

**Dialogue**

The Dialogue element is for the talked word. Celtx designs it, when PDFs are made, in the correct segment. Keep in mind, in your script, simply tap on any gatherings of words and the script elements box demonstrates to you which element it is in. To change the sort of script element, basically select that element in the drop-down menu. Dialogue resembles the accompanying screenshot in the completed PDF (right section):
Know the kind of script you're writing. On the off chance that your script is a comedy, ensure that other individuals imagine that it's amusing. In case you're writing a drama, make the exchange dramatic and holding.

Ensure your script sounds great, all things considered, dislike a robot is talking.

In the event that you've composed a motion picture script, you might need to utilize one of the film industry's online exploring administrations, to get your story and screenplay looked into by industry administrators in an ensured platform of presentation.

Before pitching a screenplay, you'll need to get electronic verification of-creation. You can do this online.

You might need to go to a script writing class, which will give you supportive indications on the subtleties of writing a full script, especially things, for example, plot development, character development, and discourse.

Make sure to make the script as unique as could reasonably be expected!

Include your own particular wind characters looks or identity.
BUDGETING

Introduction to Budgeting

A well considered budget is a reasonable arrangement for making a film. What's more, a great budget uncovers a considerable measure about how a film will be made, what sort of story you'll be telling, what sort of crew you intend to utilize and what kind of hardware you've chosen. Yet, how would you set up a budget that fits your documentary? This unit gives a stray pieces introduction on budgeting.

Preparing to Create a Budget

It is regularly said that there is a triangle of value in production: the story itself, the production schedule and the production budget. Changes to one of the three "corners" of this triangle dependably affect the other two.

Title- Production triangle

Attribution- Robert Bahar

In this way, before you can consider your budget, you should consider your story.

- What is the story you're attempting to tell?
• Who are the characters?
• What elements will it require—Interviews?
• Authentic research?
• Portrayal?
• Re-establishments?
• Dramatic elements?

Then you must plan for a schedule.

• To what extent will you research?
• At the point when will shooting start and to what extent will it take?
• Shouldn't something be said about editing and post-production?

Once you’ve drafted a schedule, attempt to list the key suspicions that you’ll need to set up the budget.

• To what extent will the film be?
• What tape, digital or film format will you utilize?
• What number of individuals will be on your crew?
• What number of "caps" will you wear yourself?
• What will your shooting ratio be?
• What amount of travel will be required?
• What deliverables will be needed?

With a depiction of the story, a draft schedule and a rundown of suppositions close by, you’re relatively prepared to begin budgeting.

Setting "The Finish Line"

Before you begin budgeting, you need to assess your objectives and set up an "end goal". Would you like to compose a budget that will empower you to make the greater part of the materials to premiere your film at a noteworthy film festival? Or then again do
you need a budget to make the greater part of the deliverables for a particular broadcaster? Would you like to incorporate making advancement materials or doing publicity? It is safe to say that you are getting ready for self distribution? These choices will have repercussions all through your budget, and you need to know where "The Finish Line" is for your budget before you can start.

Software

In case you’re savvy with spreadsheet programs like Microsoft Excel or Google Docs

Spreadsheets you can make a budget rapidly with no uncommon software. On the off chance that you favor, particular software packages are likewise accessible including

- EP Budgeting/Movie Magic,
- Gorilla Film Production
- Showbiz Budgeting

Just to give some examples. Abstain from utilizing Microsoft Word for budgets. Long tables rapidly end up unmanageable, and it's difficult to work with recipes in Word.

The Budget Top sheet

The top sheet is a one-page synopsis of the budget. It is generally created naturally by the budgeting software or spreadsheet in light of your detail budget. As should be obvious in the example, expenses are for the most part separated into two areas. "Above the-line" costs incorporate the purported key creative costs, for example, the producer, director, writer and actors (assuming any), and may likewise incorporate the costs of rights required to make the venture. "Below-the-line" costs typically incorporate the hard production costs, for example, crew, equipment and services.

Budgets can be composed in various ways. For instance, some place post-production in a separate segment and some have an extra segment for general overhead. Some like to see staff members recorded inside every department (Camera Crew recorded under Camera Department, and so on.) while others want to see the greater part of the production staff in one place.
The Detail Budget

Making a definite budget requires a great deal of research. Each budget is unique and you'll need to call potential crew, post-production offices, hotels and so on for direction and bids, and to begin arranging rates.

How about we look at the budget segment by area:

- **Research**—this segment incorporates cash for the books, videos, meetings and other expenses required to research the undertaking.
- **Test Shoots/Fundraising Trailer**—Networks and funders much of the time hope to see an example reel or "fundraising trailer" before thinking about a task. This area incorporates fundamental line things to cover a couple of shooting days.
- **Directors, Producers, Writers**—these expenses differ generally yet ought to be sensible for every individual's experience level, production locale and general budget level.

Here a solitary filmmaker is filling in as director/producer/writer and plans to spend about a year on the project.

- **Story and Other Rights**—If your project is based on a book, an article, a song or other copyrighted material, you may have to pay for the rights to make a documentary based on that material.
- **Archival Photographs and Stills**—Research the sources for any still photographs that you plan to utilize.
- **Stock Footage and Film Clips**—you should thoroughly consider the costs of both researching and licensing material. You’ll need to carefully understand the evaluating for each clip. For example, a few archives charge a 30-second least, regardless of the length of the clip that you utilize, and you should budget accordingly.
- **Talent**—on the off chance that you are planning to do re-enactments with actors or contract a narrator, you'll need to show them here. Depending on how surely understood an actor is, rates can vary considerably.
- **Music**—Music rights can end up both complicated and costly. To control these costs in the sample, it is assumed that all of the music will be written specifically for the project by a composer.

- **Production Staff**—the composition of the crew and their rates can vary considerably. In the sample, the Director/Producer has chosen to contract a production coordinator however wrap up of the delivering herself. In this case, the shooting crew comprises of a director of photography, sound recordist and production assistant. Keep as a main priority that while crew rates are certainly negotiable, it's best to maintain parity among various crew members.

- **Editorial Staff**—given the great importance of editing to documentary making, the cash allocated for an accomplished editor who is passionate about your story may simply be the absolute most important line thing in the budget. The editorial team usually incorporates an editor and an assistant. On low-budget projects, the director or an intern may play out some assistant functions, for example, logging and capturing footage. While this can be a decent cost-saving measure, be careful not to slow the editing process and make certain that you have access to a decent tech support person in case issues arise. On association projects, there may be additional edges. Check the terms of any applicable Guild agreements.

- **Production Expenses**—these segments detail the camera, sound, lighting and grip equipment, the facilities and the services required to shoot the documentary. Now and again, long-term equipment rental costs on a doc can surpass the cost of purchasing equipment. In these cases, either the production may purchase the equipment and then re-offer it at the finish of production, or a crew part may get it and rent it back to the production at a low rate. This can work out well for everybody, and the sample assumes that the Director/Producer bought the camera and the editing system and is renting them to the production. To secure itself and its funders, the production maintains a strategy that the total rental in these cases cannot surpass 75% of the actual
purchase cost, and you'll see that a multiplier of 0.75 is utilized by these things.

- "Production Film and Lab" covers videotape stock and/or hard drives utilized on-set. It would also incorporate film stock and processing.
- Travel Expenses—Travel expenses add up rapidly and may be scrutinized by funders. Attempt to keep travel to a base and contract local crew at whatever point conceivable. When you should travel, research airfare and hotel rates fastidiously and search out advice from individuals who have shot in the location before."Per diems" allow crew members to pay for their own particular meals and expenses while travelling.
- Post-Production—as issues arise amid production, somebody will invariably recommend that you can "settle it in post." But that can get costly, fast. It may be smarter to consider post the second half of a marathon. You can't afford to carry excessively baggage from the principal half. You'll be best prepared for post by doing a lot of research before you even get a camera. Call your editor, online facility, colourist and sound designer. Talk to them about the intricacies of the camera that you'll be utilizing, frame rate, time code, and synchronize and delivery requirements. Do a few tests. Talk about everything about could get complicated later. These conversations will enable you to budget your post workflow, and may also lead to suggestions that will save you time and cash amid production.

- Insurance—Production resembles war. Cars and property get damaged. Individuals get hurt. You need insurance. There are various different sorts of coverage for film productions and the most ideal way to assess your needs is to talk to several representatives who specialize in the entertainment industry. Note that some coverage, similar to laborers' compensation, is required by law.

- Office and Administrative Costs—Most of these things are self-explanatory. Note that so as to rent a production office you may be required to give an insurance certificate.

- Promotion, Publicity, Website—The line things appeared in the sample budget could certainly be increased, yet keep as a
primary concern that some funders, especially broadcasters, won't allow these things as part of the production budget.

- Professional Services—talk with your attorney ahead of time to estimate the cost of legal expenses. Unforeseen legal services add up rapidly.

- Other Required Items—Professional publicity and production stills are critical to securing placement in press and film festival catalogs. Shut captioning is required by various broadcasters.
Budget Sample

### SHORT FILM BUDGET
Summary Page

<table>
<thead>
<tr>
<th>Title:</th>
<th>Length:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Formats:</th>
<th>Shoot:</th>
<th>Post:</th>
<th>Distribute:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### PERSONNEL:

<table>
<thead>
<tr>
<th>Role</th>
<th>Phone #:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Director:</td>
<td></td>
</tr>
<tr>
<td>Producer:</td>
<td></td>
</tr>
<tr>
<td>Prod. Manager:</td>
<td></td>
</tr>
<tr>
<td>Dir. of Photog.:</td>
<td></td>
</tr>
<tr>
<td>Art Director:</td>
<td></td>
</tr>
<tr>
<td>Sound:</td>
<td></td>
</tr>
<tr>
<td>Editor:</td>
<td></td>
</tr>
</tbody>
</table>

#### BUDGET SUMMARY:

1) Preproduction Total
2) Production Total
3) Postproduction Total
4) Contingency (10%)
   
   GRAND TOTAL

#### PROJECT TIMETABLE:

<table>
<thead>
<tr>
<th>Activity</th>
<th>Begin:</th>
<th>Complete:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preproduction</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Production</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Postproduction</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### PROJECT DESCRIPTION:

Screenshot
# Short Film Budget Breakdown

**Title:**

**Dir.:**

<table>
<thead>
<tr>
<th>Formats</th>
<th>Shoot</th>
<th>Post</th>
<th>Distribute</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Length</th>
<th>Shooting Ratio</th>
<th>Shooting Days</th>
</tr>
</thead>
</table>

1) **Preproduction Breakdown:**

<table>
<thead>
<tr>
<th>Item/Service/Personnel</th>
<th>Unit Price/Rate</th>
<th>Cost:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advertising (casting)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transportation (scouting)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Photocopying</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audition facility/equip</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hospitality</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Legal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Research</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Production asst.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Miscellaneous I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Miscellaneous II</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**1) PREPRODUCTION TOTAL**

2) **Production Breakdown:**

<table>
<thead>
<tr>
<th>Item/Service/Personnel</th>
<th>Unit Price/Rate</th>
<th>Cost:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SUPPLIES:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Film stock</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video record media</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio record media</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Batteries</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gels &amp; diffusion</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Miscellaneous</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>EQUIPMENT RENTAL:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camera/lenses</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camera support</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Misc. (meters/bag/slate)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sound recorder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microphones</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Misc. audio (boom/cable)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lighting</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grip</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Misc. lighting &amp; grip</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Screenshot**
**ART DEPARTMENT:**
- Set construction/material
- Set dressing (rental)
- Set dressing (purchase)
- Prop (rental)
- Prop (purchase)
- Wardrobe (rental)
- Wardrobe (purchase)
- Wardrobe (cleaning)
- Hair & makeup
- Special Effects
- Miscellaneous

**LOCATION EXPENSES:**
- Location rental -1
- Location rental -2
- Studio rental
- Strike & restitution
- Truck / van rental
- Car rental
- Parking
- Fuel
- Public transport
- Meals
- Phone
- Insurance
- Location stills
- Miscellaneous

**PRODUCTION PERSONNEL:**
- Director
- Production manager
- Director of photography
- Asst. camera
- Gaffer
- Grips
- Location sound mixer
- Boom op.
- Prod. designer / art dir.
- Makeup / stylist
- Talent #1
- Talent #2
- Talent #3
- Extras
- Production asst.
### 3) Post-Production Breakdown:

<table>
<thead>
<tr>
<th>Item/Service/Personnel</th>
<th>Unit Price/Rate</th>
<th>Cost:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LAB WORK</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Process &amp; video dailies</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Syncing dailies</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color timing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Misc. lab work</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>FILM EDIT SUPPLIES &amp; FACILITY</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital edit suite #1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital edit suite #2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Media Drives</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Misc.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SOUND:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sound mix suite</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recording studio rental</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sound transfers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Music license fees</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sound effects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Studio (foley/ADR/etc.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Musicians</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>LAB WORK (for finishing on film or DCP):</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DI Scanning</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Grading</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conforming</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optical effects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Titles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optical audio master</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Film out inter-negative</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Film out release prints</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DCDM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DCP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HD Master</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MASTERING &amp; DISTRIBUTION:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mastering Media</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Distribution Media</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVD / Blu Ray copies</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Packaging</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Promotion &amp; fest. fees</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Miscellaneous</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>POST PERSONNEL:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Editor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sound designer/mixer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Foley/sound engineer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Musicians</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Screenshot
Unit summary

In this unit, we described the many types of productions falling under the term "audio-visual" and how Celtx makes them easier to create and use. We learned how to build a Celtx project container for our AV project and to use the AV script elements of Scene Heading, Shot, Character, and Dialogue. We learn how to make a proper budget for a video production and story breakdown, the budgeting chain systems and focus on creating the “professional” budget.

Assessment

1. Name the software's which can be used writing a script?
2. What elements go into a successful script?.
3. How do you write about the characters in the script?
4. What are the margins for a screenplay?
5. Describe the role of Script Writer?
6. Should you add copyright information on the title page of an A/V project?
7. Write an audio script Draft.
8. What is screenplay?
9. State the various expenditure heads for preparing an audio Script?

Resources

- https://google.com
- http://wikipedia.com
- http://www.youtube.com
- https://image.slidesharecdn.com
- https://www.celtx.com
Unit 3

Shooting for 5 minutes Program

Introduction

The purpose of this unit is to help you identify if video is an appropriate medium to reach your target audience and if video is the correct venue, provide you with specific examples to help you succeed in producing your own video.

Video is a great medium to tell a story. Shoot can help take your story from merely ‘telling’ to ‘showing’, and can be a very powerful teaching tool if used correctly.

It’s helpful to consider the overall workflow of creating a video. Decisions such as what the major takeaway message of the video will be, what equipment to use and the sequence of filming each have effects on other aspects of the project. This can make it hard to know where to start. A common mistake among those new to visual storytelling is to hastily jump into a new project.

Outcomes

Upon completion of this unit you will be able to:

- Name the Equipment needed for Video Production
- Develop a Checklist before going for Shooting
- Plan to Shoot NEWS
- Plan to shoot Music Video
- Plan to shot Documentary

Terminology

**DSLR:** Digital Single Reflex Camera

**Storyboard:** Shot by shot visual description

**Documentary:** A kind of non-fiction video or film.

**Scene:** Combination of multiple shots with a understandable meaning.
Production

Production is the most important part of any video, film, news and another medium. You can control the majority of the environmental variables, yet unless you have a big studio and a department or workshop where you can create sets, you're essentially up the creek without a paddle shooting anything other than a talking head, or a talking head before a green screen so you can put a different background behind your talking head. In case you're not a video production company or a system, you don't have the equipment and wherewithal to focus on large-looking productions. What do you do?

Most commercial production houses shunned shooting in the studio years ago. Going outside to create video can be somewhat scary and it can make your life, um, energizing sometimes! Regardless of how well you've scouted your locations, you will be faced with a touch of the obscure. Big production companies have the cash for bunches of lights and electricians to light them, sound equipment and individuals to operate it, video (film) equipment and whatever treats you can consider. In any case, even regardless they have a ton of questions on the set. How about we take a gander at what makes video production practical.

Equipments for video production

There are two things to think about practical video production: your equipment, and actually going out and shooting the video with your decent sparkly equipment. To begin with comes practical equipment. How about we take a gander at a practical approach to equipment with minimal spend for maximum impact.

Cameras

You can't afford to make video with a Red or an Arri or any other extremely expensive camera. You don't need expensive equipment to shoot great video. Do expensive cameras make a distinction? It depends. Good lighting makes the biggest distinction, as does understanding how to utilize the camera. In the event that you know how to light well, and have a camera operator who understands how to shoot past simply pressing the start catch, you'll do fine. We don't have all the time on the planet to get the most ideal chances to recount the story.
What can you do with a really constrained budget? How about we go up the value range. You get an affordable bit of equipment. If you are shooting HD video, one thing you can do is get a DSLR (digital single-lens reflex camera) like a Nikon or Canon. Yet, despite everything you’ll need a lens. If you want to change focus or the introduction during a shot, you need a lens that can do that unobtrusively. DSLR lenses are generally not intended to change exposures easily without a tick between f-stops. And many DSLR lens-focus engines have a tendency to be noisy. A different camera option is to get a Sony Handycam, Panasonic, JVC, or whatever kind of really portable camera that accompanies a built-in lens. Those are available in affordable cost. Another arrangement could be a Blackmagic Design Pocket Cinema Camera. It’s a genuinely professional camera without a considerable measure of extravagant accessories however it can make to a great degree beautiful pictures. It shoots RAW video, which is incredibly flexible and which you can easily color grade. RAW means the video files the camera records are sensor data with no image processing. RAW video requires color grading software (Adobe has it handily built into Premiere Pro CC) keeping in mind the end goal to be viewable (in other words, lovely).

Checklist: Before Filming

Before going to shoot something, CHECK to make sure you have not forgotten anything!

**Basics**
Camera, the field monitor, and their accessories

**Batteries**
At least 2 charged batteries each for the camera and the field monitor

**Videocassettes**
2 blank mini-DV cassettes or 2 SD cards to record on, plus an extra one, in case you need it, a head-cleaning cassette

**Audio**
- Microphone(s) (Hand-held, shotgun, or camera-mounted microphone, Lapel etc.)
• Appropriate cable for each microphone with connectors
• Extra battery for each microphone
• Professional headphones for sound monitoring

Cables

Cables for the connection from the camera to the field monitor.
Cables for the connection from the microphone to the camera.

Note: When you get to the place where you are filming, set up the equipment and make certain to CHECK picture and sound before you begin shooting.

Sound

Before you going to record audio you should check-
• Connection between the headphones to the monitor
• Placement of the microphone to capture important sounds/voices
• Quality of the sound

Camera

Before you going to record video you should check-
• Clarity and stability of the image
• Framing of the image in the monitor

How to shoot a Music Video

With late advances in computer and video technology, it’s turned out to be easier than ever to create amateur music videos. Like any artistic endeavor, the process of recording a music video can be rewarding, frustrating, and fun, trying, exhausting, and thrilling - sometimes all at once. Music videos are constrained just by your imagination and your budget. In this practical, you’ll investigate the basics of the technical and creative processes that go into making music videos.

STEP 1: Developing of the Concept

A written plan about what you should record during the activity is extremely useful so as to prepare the actual recording and further editing of the final video item. Having a schedule of the planned
activity and thinking about what you hope to happen in each of the minutes in terms of dynamics and interaction with the participants will enable you to pick beforehand those parts worth paying more attention to for recording.

**STEP 2: Proper Paper Work**

You want something to gather your contemplations, take down notes, and sketch scenes. Keep pencils and an eraser or two with your notebook and keep these things with you all through the filming process. Ideas may come to you when you least expect them.

**STEP 3: Listen the Song**

Try not to do anything else the first time — simply listen. Then, listen to it many, many more times. Listen to it with the artist. Regardless of whether you know the song by heart, attempt to listen to it as if it's the first time. How can it make you feel? Does it make you want to dance, cry, act senseless, or head for the bar? Or on the other hand does it make you feel strange combinations of feelings? When you have an idea of the song's emotional centre, brainstorm that ideas for your video. It can be exceptionally useful during this process to counsel with members of your technical staff - they'll recognize what's easy to film and what's not all that easy.

**STEP 4: Search Locations**

Before you start shooting, you'll need to know exactly where you want to shoot. Sometimes the video concept can necessitate travelling to a remote location or building a custom set. Talk to the owners or management of any location you want to utilize. Make beyond any doubt they are OK with your shooting. If you're fortunate, they may also be a perfect fit for a character in your video (if they're willing).

**STEP 5: Create a Storyboard**

A standout amongst the best video-planning tools at your disposal is a storyboard. Storyboards are shot-by-shot sketches of a video that are counseled to coordinate the video's action. Storyboards don't have to be flashy. They can be as basic as the position of
actors and props in each scene, or they can be as detailed as individual cutaways, expressions, the direction of development, and so on. If you can’t draw a straight line, don’t stress: make a content storyboard. As long as you have an idea of what is going to happen in each shot, and you can communicate that to your crew, you’ll be good to go. Hope to break your video into "scenes" that match your vision. You can minimize shooting time if you shoot all the footage in a certain location at once (regardless of whether it's out of the request it will appear in as a finished video.) Plan your shooting with the goal that you travel as efficiently as conceivable.

**STEP 6: Crew member**

Depending on the scale of your production, you may have the capacity to depend exclusively on yourself and your actors, or you may need to create large a crew for the video. Here are a few positions you should seriously mull over filling based on what work you’ll need done:

**Director:** This will in all probability be you. You'll be sharing your vision to the cast and crew, to mediating question amongst lighting and sound. You're the manager, but at the same time you're in charge of more than anyone else.

**Videographer:** The videographer will be in charge of capturing the action on at least one cameras. You'll define the shot, however he will actually frame the scene, work with the gaffer to guarantee the set is appropriately lit, and let the sound person know when the boom is in the scene.

**Sound Man:** On a shooting set, he's the person sticking mics in everyone's faces. For a video, which often doesn't feature dialog, he'll be the person cuing up the song so the actors have something to work with. In the middle of pressing "Stop" and "Play" and "Rewind".
**Grip:** This is the fortunate soul who gets the opportunity to move all the wires, all the lights, all the gear, seating, tables, props, and everything else that is expedited set. It's a ton easier to run a shoot when you have someone to handle those things while you handle the bigger-picture things.

**Costume:** you may essentially give guidance to the talent ("wear jeans and a tight shirt,"”) or have costumes made to arrange for the actors. Whichever way you do it, if there are costume changes involved, make beyond any doubt some individual can coordinate that between scenes.

**Props:** Again, this may be you, however some individual has to find the vehicles utilized, in addition to things actors on the set utilize—mustard bottles that squirt reliably on sign, anything an actor gets or puts down, or isn't part of the location.

**Choreographer:** If you do want dancers and it's in your budget, get a choreographer. They will make beyond any doubt the dancing is smooth and coordinated.

**STEP 7: Set the Stage**

Now that you have all your ducks in a row, the actors are well-rehearsed, and your crew is loaded for beer, it's time to prep your set and shoot your video. Pick a scene to shoot.

Put the objects and anything else that's in the scene into position, and have the actors stand on their marks.

Set your lighting. If this is an open air shoot, if you don’t have powered lights you may have the capacity to utilize a reflector, which is a large bit of white fabric or poster board that reflects the daylight, softening shadows and brightening a scene. For the best way to focus light, utilize more than one reflector, or even a mirror.
Keep in mind, the main person on screen is always the brightest on screen. Whenever outside, always have the main character's back to the sun except when the sun is amidst the sky. Along these lines, the reflectors can illuminate the person's face and front. Although there is a great deal to do to get efficient lighting, it is justified, despite all the trouble when you want a fantastic video.

**STEP 8: Set the Lights & Camera**

You may want to shoot part of your video on a tripod, for static scenes. Jiggly cameras can sometimes distract the watcher from the video itself. Other times you may want to utilize a handheld Steadicam for more dynamic shots, shooting a combination of angles and styles will support creative options in the editing suite. Get your actors in place. If they're in the scene as the camera rolls, have them take their marks. If they come into the scene as it plays, have them at their entrance point. If your light boys are in position then put on all the lights for that particular zone, where you are going to shoot.

**STEP 9: Set the Sound**

Locate the sound’s best possible point in the song, and give it a good lead-in time so individuals can "get in sync" with the music. Longer is better, at first. If you do multiple takes, you may have the capacity to abbreviate this part up. At the point when Sound is ready and music playing, he'll yell "speed!" The sound person may also want to feed the sound into the video.

**STEP 10: Say Action**

You know the bore here—on "Action!", the actors turn out and do the action. You may wind up with multiple takes, multiple angles, great takes, and awful takes. This is the place the fun begins.
How to Shoot Interviews

Title- Interview
Source- Interview Radio 4
Attribution- Minister-president Rutte

When recording an interview, endeavor to keep it around 5 minutes. If your video is any longer than that, you may lose your audience's attention. Follow these tips to prepare and record your video. Ask the person you're interviewing to take a gander at you, not at the camera. Endeavor to avoid a straight-on shot - shoot the person from a slight angle to the left or right.

Before the Interview

This is a pure pre-production step. These are the important rules for a good interview shooting session.

- Record and share your inquiries in advance with the interviewee. Make beyond any doubt they understand the inquiries and that the themes/things they want to talk about are secured.
- Make beyond any doubt the interviewee understands the time responsibility of the interview; recordings often take longer than anticipated.
- Ask the interviewee to wear strong, neutral colors.
• Find a decent, sufficiently bright location to record the interview. Make certain the background will help focus attention regarding your matter, instead of accidentally blending them into the background. For instance, if the interviewee is wearing white or has white hair, they may get 'lost' in the frame if placed against a white background.

• Test your camera equipment at the location to search for reflections and/or glare from windows, computer screens, and so forth.

The techniques to shoot Interview

• Set your camera up at eye level and focus it before you start the interview. When you are recording, don't change camera angles or zoom in and out unless it's necessary.

• If your subject is sitting, you ought to also sit in a chair while you're doing the interview so the interviewee does not have to gaze toward you. If they're standing, stand up.

• If you are interviewing more than one person make beyond any doubt they are in the same lighting.

• Utilize a lapel microphone to eliminate background noise.

• Speak slowly and clearly; carefully articulate your words. Be careful about using 'umm,' 'uhuh,' and other similar "filler words."

• Try not to interrupt the interviewee; wait until the point when they finish speaking to ask for clarification.

How to shoot a documentary

A documentary is any non-fiction video or film that informs watchers about a real-life topic, person, event, or issue. Some documentary films give us educational information about things that aren't outstanding. Others recount detailed stories about important person and/or events. Still others attempt to persuade the audience to agree with a certain viewpoint. Whatever subject you pick, filming a documentary can be a genuine undertaking. Follow these steps for a few tips on creating a documentary film.

STEP 1: Preparing the Concept

Try out your ideas in verbal form first. Start telling your documentary idea in story form to your family and friends. Based
on their reaction, you may do one of two things; scrap the idea completely or revise it and move forward. Though documentaries are educational; they still have to hold the audience's attention. Here, a good topic can do wonders. Many documentaries are about controversial social issues. Others are about past events that stir up strong emotions. Some challenge the things that society views as normal. Some tell the story of individual people or events to make conclusions about larger trends or issues. Whether you choose one of these approaches or not, make sure you pick a subject with the potential to hold an audience’s attention.

**STEP 2: Schedule your Shooting**

<table>
<thead>
<tr>
<th>What is to be done &amp; where</th>
<th>Planned Date &amp; Time</th>
<th>Who is responsible?</th>
<th>Resources required</th>
<th>Date completed</th>
<th>Changes made after completion &amp; why</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proposal of ideas that would be presented to a production company</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Budget (List of resources and equipment to be used to find our total cost)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Script</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Storyboard</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location Scout</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Created by author

You don’t necessarily need to know exactly how your documentary is going to come together before you start shooting - you may discover things during the process of filming that change your plans or offer new avenues of investigation. However, you should definitely have a plan before you start shooting, including an outline of specific footage you want to shoot. Having a plan ahead of time will give you extra time to schedule interviews,
work around scheduling conflicts, etc. Your plan for shooting should include:

1. Specific people you want to interview - make contact with these people as early as possible to schedule interviews.

2. Specific events you want to record as they occur - arrange travel to and from these events, buy tickets if necessary, and get permission from the event's planners to be able to shoot at the event.

3. Specific writings, pictures, drawings, music, and/or other documents you want to use. Get permission to use these from the creator(s) before you add them to your documentary.

4. Any dramatic recreations you want to shoot. Search for actors, props, and shooting locations well ahead of time.

STEP 3: Interview Relevant People.

Many documentaries devote much of their running time to one-on-one interviews with people who are knowledgeable about the subject of the documentary. Pick a selection of relevant people to interview and collect as much footage as you can from these interviews. You'll be able to splice this footage throughout your documentary to help prove your point or convey your message. Interviews can be "news style" - in other words, simply sticking a microphone in someone's face - but you'll probably want to rely more on one-on-one sit-down interviews, as these give you a chance to control the lighting, staging, and sound quality of your footage while also allowing your subject to relax, take his or her time, tell stories, etc.

1. These people may be famous or important - well-known authors who have written about your subject, for instance, or professors who have studied it extensively. However, many of these people may not be famous or important. They may be ordinary people whose work has given them a familiarity of your subject or people who simply witnessed an important event firsthand. They can, in certain situations, even be completely ignorant of your subject - it can even be enlightening (and entertaining) for the audience to hear the
difference between a knowledgeable person’s opinion and an ignorant person’s opinion.

2. If you’re stumped for interview questions, brainstorm questions based on the basic queries "who?" "What?" "Why?" "When?" "Where?" and "how?" Often, asking someone these basic questions about your subject will be enough to get him or her to relate an interesting story or some enlightening details.

3. Remember—a good interview should be more like a conversation. As the interviewer, you must be prepared, having done your research and informed yourself to glean the most information from the interview subject.

STEP 4: Get Footage from Film

One of the main advantages of documentary films (as opposed to dramatic films) is that they allow the director to show the audience real footage of actual real-life events. Provided you don't break any privacy laws, get as much real-world footage as you can. Film events that support your documentary's viewpoint, or, if the subject of your documentary happened in the past, get in touch with agencies or people who have historical footage to get permission to use it. For instance, if you’re making a documentary on police brutality during the Occupy of Posco land protests, you may want to contact people who participated in the protests and collected hand-held footage.

In historical documentary, we'd obviously want lots of footage of temples taking place in and around odisha. If we’re creative, though, there are plenty of other things we might want to film: a discussion on a proposed temple protection, for instance, might provide some thrilling dramatic tension.

STEP 5: Film Establishing Shots

If you've watched a documentary before, you've surely noticed that the entire movie isn't just footage of interviews and of live events with nothing in between. For instance, there are often shots leading into interviews that establish a mood or show where the interview is taking place by showing the outside
of the building, the city skyline, etc. These are called "establishing shots," and they're a small but important part of your documentary.

1. In historical temple documentary, we'd want to film establishing shots at the locations where our interviews took place: in this case, Temple walls, Badadanda shops, Puri beach etc. We might also want to get some footage of near far temples in puri landmarks to give the audience a sense of the locale.

2. Always collect audio from the shoot including room tone and sound effects unique to that location.

**STEP 6: Shoot Dramatic Recreations**

If there's no real-life footage of an event your documentary discusses, it's acceptable to use actors to re-create the event for your camera, provided the recreation is informed by real-world fact and it's perfectly clear to the audience that the footage is a recreation. Be *reasonable* with what you film as a dramatic recreation - make sure that whatever you commit to film is grounded in reality. Sometimes, dramatic recreations will obscure the actors' faces. This is because it can be jarring for an audience to see an actor portray a real-world person in a film that also contains real footage of him or her.

**STEP 6: Keep a Note.**

As you film your documentary, keep a note of how the filming went each day. Include any mistakes you made as well as any unexpected surprises you encountered. Also consider writing a brief outline for the next day of shooting. If an interview subject said something that makes you want to pursue a new angle for your film, note this. By keeping track of each day's events, you have a better chance of keeping on track and on schedule. Once finished, do a paper edit viewing footage and making notes of shots to keep and others to discard.

Then goes to next step post production for your documentaries.
How to Shoot News

Concept of News

Before starting any news report, the most critical point to recollect is: Keep it simple. Consider how you might recount the story in the most captivating path, without making it excessively confounded.

Planning for News

Similarly as with any story, you should arrange for how you need to begin your news report and how you need to end it. This will keep your story heading in the right direction, and you won't pass up a major opportunity any important information in the middle. When planning your report, you should think about the five ways. These are:

- **What** - What is the story? Get the actualities right before starting your report.

- **Why** - Why is the story important to your gathering of people? Which indicates do you require focus on to get their advantage?

- **Who** - Who is included? Consider who will have the capacity to recount their sides of the story in an intriguing way. Ensure they're accessible to film when you require them.

- **Where** - Where is the story happening, and where is the best place to film? In case you're shooting outside of a lodge, you may need to get consent first.

- **When** - Has the story as of now happened, or is it going to happen? On the off chance that there will be a noteworthy occasion you need to report on, ensure you arrive on time!

By planning every one of these focuses in detail, you'll know precisely what you have to film, where and when. That way, you won't pass up a great opportunity for anything when you’re on location.
Equipment for News coverage

Always bring a lot of pens and paper, spare camera batteries and SD card. On the off chance that you run out amid an interview, you won’t have the capacity to complete your story. What’s more, on the off chance that you have a tripod, take it with you to keep the shots steady.

Shooting the news

When you have done all your planning, at that point you can begin to film. A fundamental TV news report is comprised of five sections:

- Introduction - This is the place the reporter starts to clarify the story. Try not to make it too long, keep it short and snappy.
- First interview - The first person you converse with will give their opinion on what is occurring, and how it affects them.
- Second interview - You have to converse with someone with an alternate opinion, to give balance.
- Extra shots - These show the audience more about the place and the general population in the story. They make the report additionally interesting.
- Conclusion - This will be the reporter's sign-off, where they summarize the outcome, or possible outcomes, of the story.

Contemplate where you need to set up every one of the shots, using distinctive backgrounds and angles to keep it interesting for the audience.

For instance, reporters can look straight at the camera when they do their introductions and sign-offs. These are called "pieces to camera".

The interviewee stands on one side of the frame looking to the reporter on the other side. Consider how to position your interviewee in the shot. Interviewees usually stand on one side of the frame looking over to the other side of the screen. This is
because they are looking at the reporter, who stands on one side of the camera, so you can't see them in the shot. Be exceptionally watchful to check your audio levels too. Wear your headphones! Without great sound you won't have the capacity to use the video that goes with it.

**Precaution**

When filming, you and your group's safety is top need. Don't film in dangerous places - in the street, for instance, or adjusting on top of something. Be cautious of cables and leads - keep them off the beaten path so individuals don't stumble over. Planning ahead can truly enable, so you to know where you're going and don't get lost. Always ensure someone in charge knows where you will be.
Unit summary

In this unit you learned the Basics of shooting. You were able to examine the ‘Elements of Shootings’ and ‘Principles of recording’. How to add aesthetics to any composition? Why these elements are important for any project.

We also addressed about ‘Fundamental of shooting’ and able to distinguish type of video shoot. How their properties are different from each other? You also learn the difference shooting techniques and the shooting chain systems.

Assessment

1. List any three equipments used in shooting process.
2. Write the points you will keep in mind while shooting a music video?
3. Explain the principles to shoot an Interview?
4. Describe the use of storyboard.
5. Write the use of lapel when you are recording.
6. Write the step you performed as a director.
7. Differentiate between music video and documentary.
8. State the primary tools for lighting?

Resources

- https://www.google.co.in/
- https://www.wikipedia.org/
- https://www.youtube.com/
- https://www.wikihow.com/
- https://library.creativecow.net/
- https://pixabay.com/
Unit 4

Editing of 5 minutes Program

Introduction

Editing is an essential part of making any film or video. Capturing high-quality video has never been easier, but capturing video is only part of the storytelling process. And it doesn't even have to be storytelling; it could be sharing an experience, presenting information, or covering news. To get video from its raw form to a finished, watchable piece, it needs to be edited.

A lot of folks think video editing is complicated and hard to learn. But it doesn't have to be! In this unit you will learn the basics of video editing. You will learn how to import and organize your footage and assets, how to trim clips and add them to a timeline, and how to sweeten audio. You will learn about color correction and grading, video effects and transitions, and more! This way you can follow along and get real, hands-on experience.

At the end of this course you will have the skills to start editing your own projects so that you can get started telling stories of your own.

Outcomes

Upon completion of this unit you will be able to:

- List the types of movie editing
- Practice the steps of Editing
- Choose the Right software’s for editing
- Plan to edit music video
- State the Important Editing rules
Terminology

**Off-Line Editing:** This is the process in which the raw footage is copied and edited at a lower resolution than the final output, and an online EDL is created to be used in the final assembly of a picture.

**On-Line:** This process is to an electronic edit what a negative cutter is to a picture completed on film.

**PAL:** *(Phase Alternate Line)* The 625-line, 25 frame per-second television standard used in Western Europe, India, China, Australia, New Zealand, Argentina and parts of Africa.

**Real time:** Real time the ability to interact with data as it’s being created.

**Pan and Scan:** It is a method of converting a widescreen image to a 4:3 (standard television) aspect ratio for projection or television.

**VTR:** Video tape recorder also referred to as a “deck.” They’re used for duplicating video tapes and inputting and outputting from a computer.

Editing

**Non-linear (film style) Editing**

Non-linear editing is best for highly structured, short-format projects. When professionally done, tightly edited tapes of highlights usually take about one hour to edit 1 minute of the final segment. The more time you spend editing, the better your video can be, but don’t overdo it.

- Non-linear editing is like writing an essay with a computer.
- Video segments called “clips” are digitized to a hard disk.
- Any shot can be accessed instantly and at random and can be shortened, lengthened, juxtaposed, moved or removed.
- Video and audio changes can easily be cut and pasted.
- Rough Edit: On this first pass, edit the original material by choosing the best clips. No transitions or audio mixing are added yet; the story structure is simply assembled in order to make sure the intended story comes through clearly.
• Tight Edit: Make a second pass adding transitions between scenes and a third pass cleaning up the sound and adding music, if any.

• Before final mastering, add titles to identify people, places, and things; to help tell the story, or to give credit. Titles are rendered. Bars and tone can be added to the beginning for future reference.

• Final Mastering: The final step is to playback the program on the computer and records it onto your preferred medium (hard drive, Blu-Ray, DVD, Mini DV).

Source—
http://web.mit.edu/techtv/videoprodguide/editing.html

How to Edit a Video?

To begin with thing you recollect that as an editorial manager you are a storyteller! Editing is far beyond basically cutting footage. It's a chance to take your audience on a voyage. Regardless of whether you're editing a mind boggling narrative film or just assembling a corporate video, that doesn’t matter, but every cut, every transition, every sound effect, and graphic needs to recount a great story. So while you're editing, ask yourself how each scene is advancing the story. Audiences cherish struggle. Find that contention and emphasize it through pacing and music, you have to do when you take a seat to alter a video is figure out who your hero is. For a video, the hero may the interviewee or even the audience. Release your hero on an excursion and defeat obstacles — regardless of whether the obstacle is as trivial as not realizing what sort of toothpaste to choose. Utilizing this procedure will change the way in which you alter and you'll instantly observe a change in your video's quality.

Amid the editing process, you should assemble all of the various content you have gathered. This may incorporate video clips, still shots, slide images, voiceovers, and music. You may deliver an audio program, a video, or an image slideshow amid this phase.

Choose the Right Software

Picking the correct editing software is a considerable measure like picking the correct car. They'll all get your from A to B, yet relying upon your tastes and inclinations, you may lean toward one above
the rest. The accompanying is a brisk breakdown of the most popular professional video editing software on the planet. You can use to alter and produce your video. Take a glance at these to decide the best fit for your ability level and spending plan.

- Free: Openshot, Avidemux, Cinelerra, Blender, windows movie maker, Filmora
- Moderately priced: Camtasia
- Professional: Final Cut Pro, Adobe Premiere, Avid

Here we are going to discuss about the Open source software Open Shot video editor software. Because, it is free for user and user friendly for beginners.

**Learn the basics of your editing interface**

![Openshot Video Editor Interface](http://www.openshotusers.com/help/1.3/en/)

**Title-** Openshot Video Editor Interface


While diverse programs have distinctive features, the basics of most software are quite similar. Indeed, even straightforward programs have a considerable measure of tools and buttons, yet
there are three main parts to every video program that you should know:

**The Timeline:** This is the place you arrange, alter, and trim your footage into the final video. Here and there known as a "sequencer" or "storyboard editor" this is the place you do the majority of your work. Most programs indicate both audio and video in the timeline. It is usually near the bottom of your window.

**The Preview Screen:** This is the place you watch the draft of your motion picture while you alter. It usually starts out as a black box with play, rewind, and stop buttons underneath it. It is usually in the upper right quadrant.

**The Library/Collection:** This is the place all of your imported audio, video, and pictures are arranged, allowing you to drag and drop them into your timeline for editing. It usually accompanies a search function and some labeling tools. It is usually on the left side of the window.

Different areas may incorporate audio controls, a "toolbox," special effects, a place to add titles, and a moment video screen to check imported footage.

**Know the essential tools for editing**

1. Add Track: Add a new track to the top of the stack.
2. Select Mode: Select mode allows you to click and move clips.
3. Razor Mode: Razor mode allows you to split a clip wherever you click. If snapping is enabled, clicking near the play-
head (the red line), will slice the clip exactly on the playhead.

4. Resize Mode: Resize mode allows you to grab the edges of a clip and drag to resize (or trim) the clip.

5. Snap Mode: Snap mode allows clips to snap (or jump) to the nearest clip or play-head (if any are close) when you drop them. Transitions will snap to nearby clips. Also, clips and transitions will snap to the play-head's position.

6. Add Marker: Add a new marker, which allows you to quickly jump back to this exact point while previewing.

7. Previous Marker: Skip to the previous marker (if any).

8. Next Marker: Skip to the next marker (if any).

Organise your Footage

Regardless of whether you are producing a simple video or a feature to film, the well-organized footage is significant to forestall misfortune, streamline your editing process, and help other team member's hop into the venture without confusion. Despite the fact that it might be an issue at to start with, completely naming and documenting your video footage will spare endless cerebral pains later on.

1. Organize folders by project and the date it was shot. Ex. E:\Movie\Project_2-22-17.

2. Organize clips by scene and take. Ex. E\Movie\Project_Scene1_Take1.
Create a New Project

Title- New project window

Link- http://www.openshotusers.com/help/1.3/en/ar01s05.html#sect2_21

Depending on your footage several options will appear here, but standard digital video quality will be 720x480 or 1080x720 (High Definition) at 25 frames per second. These settings are called PAL standard and are used in most countries. If you are in doubt, ask the cinematographer or director what settings they shot the video on.

If you're still lost, look up your camera's settings on the internet -- it should tell you what sort of video you are editing. Many modern programs will automatically conform project settings to your footage, eliminating this headache for less experienced editors.
Import Your Footage

Title- Importing files

Link- [http://www.openshotusers.com/help/1.3/en/ar01s06.html](http://www.openshotusers.com/help/1.3/en/ar01s06.html)
Link- [http://www.openshotusers.com/help/1.3/en/ar01s05.html#sect2_21](http://www.openshotusers.com/help/1.3/en/ar01s05.html#sect2_21)

Though all programs are different, you can usually bring your film clips into the project under File--->Import. This does not make your movie or order your clips, it simply tells the program which videos you will be editing and allows you to access them.

1. Some programs let you drag and drop footage from another window into your editing window.
2. Importing footage allows for Non-Linear-Editing (NLE): the process of editing video out of order without changing the original footage. All modern editing is Non-Linear.
Drag and Dropping of clips in timeline

**Title**- Dragging & dropping of clips in timeline

**Link**- [http://www.openshotusers.com/help/1.3/en/ar01s03.html#sect2_5](http://www.openshotusers.com/help/1.3/en/ar01s03.html#sect2_5)

Start building the skeleton of your movie by ordering your clips and choosing which shots you like the most. You can always drag clips into new spots after you place them. Start working on a few minutes of the video at a time to prevent becoming overwhelmed. Click on a file, drag over the timeline and drop it. The clip will now be added to the timeline.
Splice the scenes together

Title- Splice the scenes

Link- https://www.kurup.org/blog/2011/08/10/openshot-video-editor

Once you have the scenes in order you need to trim the beginning and ends so they line up cohesively. While sometimes this is as easy as eliminating the initial "Action!" you'll have to make artistic decisions here too. To splice, find the "razor" or cut tool to break the footage up into smaller parts, and then delete the parts you don't like from the timeline.

Many programs let you drag the beginnings and ends of clips to shorten or lengthen them.

Never permanently delete any footage-- you never know what will come in handy, even if only for the "blooper reel!"
Add transitions and effects to footage

Though these are essential to most movies, they can only be effective once you have the footage completely organized and cut. Most programs have dedicated windows and menus for titles and transitions, and you should play around to see which fit your project.

The most common transitions are "fade-ins" and "fade-outs," which is when the image slowly appears or disappears from the screen.

For more complicated special effects, transitions, or animations, editors often rely on separate post-production programs like Blender.

Add Music

To make the Video more interesting, you need to add some music. You should have imported a music file. Click on the music file, and drag it onto Track 1 on the timeline.

Title- Adding music

Link- https://www.openshot.org/static/files/user-guide/quick_tutorial.html
Balancing of Sound

It appears like each video editor has their own particular feelings about what your audio levels ought to be, so the accompanying suggestions are in no way, shape or form law. Notwithstanding, in case you're experiencing some difficulty getting your audio without flaw, simply take after these speedy recommendations and start changing your audio from that point.

- Overall Mix Level: -10db to -14db
- Dialogue: -12db to -15db
- Music: -18db to -22db
- Sound Effects: -10db to -20db with occasional spikes up to -8db.

By the day's end, your ears should be the judge. Your audio may take after these tips consummately, however in the event that it sounds awful... it’s terrible.

Adjust the colour

Not all movies need to take this step, but if you want to look professional you'll need to balance audio and video so that the shots all look alike and there are no jarring volume shifts. Luckily, many programs have an "auto color-correct" function and "volume equalizer" built in. For a professional looking film you'll need to do this manually.

Color correction is the way toward getting your footage to a color baseline. Regardless of how incredible your footage looks on set, you will quite often need to do some fundamental post-preparing to get the greater part of your footage reliable. The greater part of the major NLEs have fundamental color correction effects worked in that make it simpler than ever to perform essential color correction. However, you might be somewhat constrained on your capacity to control colors on the off chance that you are given a highly compressed codec. Remember this when shooting your footage on set. Record groups like RAW and ProRes will be simpler to control than h.264 and AVC-HD.
Titles and Graphics

After you've edited your video, included music, and color graded, it's an ideal opportunity to include the graphics. While it's anything but difficult to spot awesome motion graphic work when you see it, great graphics are shockingly hard to create yourself. It's extremely best to keep things simple.

Once the title editor dispatches, you have to choose a template and tap the Create New Title button. The will make a duplicate of the template SVG title, and add it to your Project Files. Enter the name of the record, as it will be spared to your hard-drive.

Preview video at various point

Title- Preview window
You may need to rehash this stage five, ten, or even fifty times relying upon the project, and it will feel monotonous. Welcome friends, co-workers, or other crew members to watch the project with you and give feedback. Take notes of each time you watch it about what you need to settle. Removing a couple of days from the project before watching can help gather new bits of knowledge.

Export your Video

![Export Video Window]

Title- Export window

Link- [http://www.openshotusers.com/help/1.3/en/ar01s03.html#sect2_7](http://www.openshotusers.com/help/1.3/en/ar01s03.html#sect2_7)
Once you have completed a project, the next step is export video. This will convert your Open Shot project into a single video file, which should work on any media player. Open Shot has many predefined formats to simplify this process. There are two modes to export a video in Open Shot, Simple Mode and Advanced Mode. Both modes share a common area at the top of the screen, General Options. Name your video file (no extension) and choose an export folder.

Click on the Export Video icon at the top of the screen (or use the File > Export Video... menu). Choose from one of the many preset export options, and click the Export Video button.
Audio Visual Production

Unit summary

In this unit you learned the **basic steps of editing**; After reading the steps of editing, you can do video editing. How to edit videos? Why these rules are important for any edit.

We also addressed about ‘Fundamental of editing’ and able to distinguish different types of editing. How their rules are different from each other? You also learn the difference Studio setup techniques and the editing steps.

Assessment

- List the software is used in editing?
- List the steps to edit?
- Explain the need of using principle of editing?
- Describe the use of music in editing.
- State the role of an editor?
- Differentiate between linear and non linear editing.
- Identify the primary tools for editing?
- Name the tool which is used for cutting a video clip?
- Describe how to import video in project?
- Audio overall mix level is---?
- Dialogue level is-----?
- PAL stands for?
- RGB stands for?

Resources

- [https://www.google.co.in/](https://www.google.co.in/)
- [https://www.wikipedia.org/](https://www.wikipedia.org/)
- [https://www.youtube.com/](https://www.youtube.com/)
- [https://www.wikihow.com/](https://www.wikihow.com/)
- [https://library.creativecow.net/](https://library.creativecow.net/)
- [https://pixabay.com/](https://pixabay.com/)